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Introduction

Congratulations for the start of TI-jPACS. Now you get a very efficient program for archiving of 
medical images from the most different modalities in the international DICOM format. The image 
visualization functions serve particularly for not diagnostically viewing and the comfortable user-
friendly management of the archived images.

Congratulations on selecting TI-jPACS system, which represents an efficient program for medical 
image archiving from different  modalities  of  the  international  DICOM format.  The application 
contains Image Visualization functions that allow users to archive images via reliable and user-
friendly interface.

By using this application, hospitals, medical and rehabilitation centres have ability to adjust images, 
make changes and access database for obtaining information. They can share information between 
each other via Internet or Intranet.

:
TI-jPACS offers the following advantages

• Optional user-friendly handling  to sort from different sorting of images, patients,series
• Fast preview available.
• Unification, Management and Storage in one program
• Front-end is independent from the producer of the DICOM-database.
• DICOM Viewer with a lot of useful features .
• High flexibility, scalability and extensibility of the system
• Independence from the operating system
• User management
• Import of DICOM images via DICOMDIR- File 
• etc...

NEWS 

Completely revised DICOM Viewer for more flexibility,  performance and higher usability (see 
Illustration 1)



New settings in the Patient management browser for more performance by search and show of 
patient data (see Illustration 2).

Illustration 2: Time settings in patient management browser





1. Program components

TI-jPACS included following modules:

• Management and storage tools

• DICOM-Server

• DICOM-CD/DVD-creator for generating patients-CDs/DVDs, alternatively with DICOM-
DIR-data and an effective DICOM-viewer

• DICOM-viewer  (internal):  for  the  observation  of  DICOM-images  in  the  DICOM 
management and storage system (a lot of professional useful features), one of the best java- 
based**  image processing engines world wide. 

• DICOM-viewer (external): for the viewing of DICOM- images after storage (independent of 
the operating system)

• DICOM-Send-Module  for  sending  of  DICOM-  images  via  DICOM-protocols  to  any 
DICOM-nodes (other DICOM-compatible applications)

• Universal DICOM-database-front-end for deriving of DICOM- images from any DICOM-
databases via DICOM-protocol (FIND- and GET-order)

• DICOM-e-mail for sending selected DICOM-pictures (or after compression with JPEG or 
AVI)

• DICOM-format modification for saving DICOM-pictures (BMP-, TIFF-, AVI- JPEG- and 
anonymous DICOM-pictures)

• DICOM-import for importation of DICOM-pictures from a DICOM-Server or from a file-
system

• DICOM-database (optionally)

• DICOM Images – anonymization 

• Overlays visualisation 

• Settings of  DICOM-Images Relevance

• Import of DICOM images via DICOMDIR- File 

• Advanced user management

** Without native acceleration. 



2. Setup and configuration issues

2.1. Technical requirements

The installation of the TI-jPACS doesn't require special components. You install the program on 
any computer conforming to the following requirements:

• Intel Pentium III 1000 MHz or AMD  Athlon / Duron 1200 MHz processor

• Random access memory 256 MB or higher (better)

• 40 GB free fixed-disk storage for DICOM –Image archives (depending on the data-volume)

• Network interface card (10/100mbit): for access to a network or a video projector

• 32 MB graphics adapter or higher

• CD- or DVD-writer

• Operating system: MS Windows 2000 or XP

2.2. Selecting the installation directory.

We advise you to install the program on a self-contained Windows-partition,  especially, if  you 
intend to save a large amount of data. Also, you have to make sure that the fixed-disk storage offers 
sufficient space for date administration.

2.3. Installation

Program installation requires administrative rights for successful drivers installation. English-based 
wizard programs will guide you during the installation and will help you to prevent mistakes.

In order to use CD-Burn function of TI-jPACS please install ASPI - Driver (* only for PC 
with Windows 2000 or Windows XP). ASPI Driver can be downloaded from www.chip.de 
(http://www.chip.de/downloads/c_downloads_8833907.html). 
 

We already downloaded this Driver for you.

ASPI - Driver are already in the installation folder:
 
C:\jPACS\PROGRAM\PLUG_INS\CDRTOOLS\driver\....

http://www.chip.de/downloads/c_downloads_8833907.html


Guidance for the installation of ASPI Driver 
**** The installation of ASPI Driver is a harmless and unique procedure for your PC. 

1. Please login at your PC as administrator (otherwise the installation of ASPI Driver is not 
possible).

2. Open the folder:
C:\jPACS\PROGRAM\PLUG_INS\CDRTOOLS\driver". In it are three ".exe"-files with the 
names:  "1.exe", "2.exe" und "3.exe".

3. Run these successively. First the program (1.exe) then (2.exe) and (3.exe). During the in
stallation the PC will be started once again.

4. The third program (3.exe) is for control of ASPI-Driver installation: If “green” is shown in 
the window then everything is correct. If "RED" is shown in the window then the installa
tion was not successful. Please start your PC again and run the program 3.exe. We will help 
you with any problem during installation.

 After the successful installation of ASPI Driver you can use CD-burn function of TI-jPACS.

2.4. Basic Configuration

After installing TI-jPACs you have to do the following settings to prevent errors:

• Select the writer (CD- or DVD- writer)

• Configuration of the burn-program, in case of using CD or DVD-writer

• Configuration of the DICOM-server, connecting the IP address of the computer to image 
equipment/ workstation

• Set-up of the recorders

Besides you have to call up the menu-point [Options-> general options] (Illustration 3).
Hereupon you have to choose the card [CD/DVD-settings] and insert your maximal copy-speed and 
the record-buffer there. This dates you can get from the manuals of your CD-/ DVD-writer.

Illustration 3: Options menu

The data for the CDR-DEVICE-parameter you can get (Illustration 4),  from the DOS-window. 
Besides you have to call up the option [record test] from the program-point [TI-jPACS].



Illustration 4: CDR-tools parameter

If you're not sure for your setting, we advise you to keep the standard settings.

For the enabling of a DICOM-CD/ DVD you can write a DICOM-DIR-data. Besides you have to 
activate the control-box in the CD- DVD- settings. Furthermore you're able to copy the DICOM-
viewer  (external)  to  a  CD-DVD.  So you can  consider  using  the  images  on  another  computer. 
Besides you have to activate the respective control-boxes.

After configuration, choose the button [save] and close the window. 

2.5.  Display Calibration and measurements on display



2.6. Set-up the DICOM-server and the network

The DICOM-server will be installed as a pre-configured mode.

In order for the DICOM-server to be able to do its job, the computer has to be activated, i.e. you 
have to enter the IP address of the computer and the port 104 (standard DICOM-port) of the image 
equipment / workstation.
 This setting should only be taken place by a computer-expert.
You can insert following application entity titles in configuration-file**  
   -aet  --aetitle            aetitle: string
                              set my calling AE title (default: STORESCU)
   -aec  --call               aetitle: string
                              Set called AE title of peer (default: ANY-SCP)
** The link to configuration -file is in start-up –folder



2.7.TI - jPACS user management and access control.
This software has an advanced user management plug in. It is possible to change between 2 
mode: 1. Login /Password control access mode  (see Illustration 3)  and  2. free access 
mode.

For change of properties and create a new user accounts see Illustration 4

Illustration 5 Login frame

Illustration 6:  User management 
  

2.8. Time settings for configuration of patient management browser.
It is possible to change time settings for visualisation of the patient table in the patient management 
browser. It can be very useful in the situation, when you have a lot of patients (thousands of 
patients). So it is possible to shorten the patient list.



 

2.9.TI - jPACS (multilingual) Registration.

By the registration receive you from us a free program-support and useful Tips for efficient working 
with TI-jPACS. 
User Registration 
    First Name:        
    Last Name:       
    Job Title:  
    Company:       
**  E-mail Address:     
    Country: 
*** Registration ID: 
** Must be a valid e-mail address.

*** Insert your REGISTRATION-ID after 
installation, see illustration: 



3. Survey of the system

3.1 System overview 

Illustration 8: Dual Monitor representation of TI-jPACS. Management-browser (left) and DICOM-Viewer 
(right)

The following images show you the buttons and their functions:

Illustration 9: control elements



3.2 Image management browser

The image management browser helps you with a partial selection of images; it sorts in patients, 
modalities and image series. The browser makes the current display and sorting of images in the 
categories  ''patients''  or  ''date  of  check-up“.  It  shows  as  a  tree  (Illustration  10).  The  image 
management browser supports the searching in accordance with the 
Following criteria:

• Name of the patient

• Gender

• Date of birth

• Patient-ID

Illustration 10: image management browser (different views)



The image that you chose in the image management browser will show you in the preview browser 
(see in chapter 4.4).

3.3 DICOM-VIEWER

The  DICOM-Viewer  is  able  to  show  you  the  DICOM-images  in  the  complete  picture  mode 
(Illustration 11).

Illustration 11: DICOM-Viewer (example)

3.4 Image preview browser



The image preview browser offers you a midget-view for all images, which you selected in the 
management browser (Illustration 12). With the buttons above the image preview you are able to 
change the size of the image preview. The program is also able to show all images of one series 
(CT- or MR-images) in a sequence (back-to-back option). Besides you have to press the respective 
button (only possible with CT- or MR-series) above the preview-window.

Illustration 12: Image preview browser

If you press on one of the preview images with the right mouse-button, you will see a small menu, 
where you can select the favoured option (Illustration 13).

Illustration 13: Popup menu to preview image

3.5 Program presentation on two displays

The program is able to recognize two display devices, if they are connected. In this case the two 
displays show separately the image management browser and the DICOM-viewer (Illustration 14).
 



Illustration 14:  Program presentation on two displays

If only one display connected, the both modes will be ordered as the following. (Illustration 15). 

Illustration 15: Changing of displays by single-monitor use

3.6 Language- and layout-settings

You are able to select either English or German
With the option [Options -> Look & Feel] you can change the background-colour, the font-settings 
(colour, size) and the marking of the flags in the DICOM-viewer. In addition you can select  a 
detailed or a brief description of the objects. For example you can only see the name of the patient 
in the shorter version. In the detailed version you are able to see the date of birth, the patient-ID and 
the gender of the patient.

Please attend, that you have to restart the program for activating the modifications.

3.7 Audio- and Text- Comments for archived DICOM-Data.
TI-jPACS is able to create, edit, play or write the audio- or text- comments.



Such comments can be written on CDs/DVDs and read by DICOM-Viewer from CD or DVD. 

3.8 Relevance settings for DICOM Images. 
You can  change the relevance  for  DICOM Images  from “normally” (default)  to  diagnostically 
relevant or to “relevant for education”

3.9 Activation of the plug-ins

For using some options of the system you have to activate the respective plug-ins. Your activated 
plug-ins are marked and they are visible in [Options-> Plug-ins] (Illustration 16). For using non-
activated plug-ins you require an activating-key. If you have an activating-key, you can mark the 
respective plug-in and insert the key in the following window. Now you are able to use the new 
plug-in. 

Illustration 16:  Plug-in activation console

3.10 Features of the system

You are able to use the following options:

• Visualisation and processing of DICOM-images
• Print DICOM-images
• Archive DICOM-images
• Import DICOM-images
• Export DICOM-images in other formats
• Creation of DICOM-CDs
• Delete DICOM-images
• Send DICOM-images
• Connect to a DICOM-database
• Import of DICOM images via DICOMDIR- File, from File-System and via STORE SCP

These options are specified in the following chapter.



4.  Appliances and cases

4.1 Visualisation of DICOM-images

If you want to view a DICOM-image with the DICOM-viewer, you should select it in the image 
management browser. Click with the right mouse button on it and select the option [Change to 
DICOM Viewer  (full  screen)]  (Illustration  17).  Image  will  appear  on  complete  picture  mode. 
Alternatively,  you may click  on  the  favoured  image in  the  preview window (with  left  mouse 
button). 

Illustration 17: Menu with different options

Now you have opened the image in the DICOM-viewer. This integrated viewer offers you different 
options, which you can see in  Illustration 18. For the appliance you have to attend the following 
scores:

• Measure the distance

- Activate the button [distance measurement]
- Move the mouse pointer to the starting place
- Press the right mouse button, moving the mouse to the favoured end point and release the 
button

• Goniometry



- Activate the button [goniometry]
- Move the mouse pointer to the starting place
- Press the right mouse button, move the pointer in the direction of the favoured goniometry and 
release the button
- Press the right mouse button again and move the pointer in the direction of the end point

• Measure the brightness and the contrast

- Activate the button [brightness and contrast]
– Press the right mouse button and with a slow vertical motion set the brightness (above for 

brightening [+], below for shading [-]). With a slow horizontal motion you are able to set the 
contrast (left for lower [-], right for higher contrast [+]).

– Live -Windowing with Histogrampreview 
–

 By movement /reduction /extension of blue bar can you change the window-center and window-wight 
of current image

• Magnifying glass

- Activate the button [magnifying glass]
- Select the favoured size
- Press the right mouse button und scale up the favoured array with a vertical and/ or a horizontal 
motion

• Re-establishment in the initial state

– Click the button [original-establishment]

• Save and edit of ROI-Objects (as distance /angle/surface measurements)
It is possible to save results of different measurements by pushing of the button “save ROI”. 
Please take a care, that you save the measurements for “selected” image.
If you open the same image later, you can see your “old” measurements. For edit/delete  of the 
measurements please mark “correct” image as “selected, an push the button “Edit ROI”. See 
next Illustration



Illustration 18: New DICOM-viewer GUI -elements 

Abbildung 1: RIO- Management



Warning, all operations, after pushing of the control buttons will be applied  on “selected” image!
To mark the image as “selected” is enough a short mouse-button- click on the image surface.  
See the  for understanding of the visual difference between “selected” and “not selected” images 

Further it is possible by 2 or 4-images frame splitting to move the images between splitting-parts 
(see Illustration 20)

Warnings for the usage of the new DICOM-Viewer-controls
All Functions of the Viewer are in groups collected. They collapse every times, if other one group 
was expanded. For control of this behaviour please use Buttons  “fixed” or “not fixed” see 
Illustration 21.
    

4.2 Storage of DICOM-images on CD or DVD
Please install ASPI –driver (see in chapter 2.3 of this manual) and configure the CD-burn 

Illustration 19: Active and not 
active images

Illustration 20: Buttons to 
movement of image in all directions

Illustration 21: Controls for expand / collapse of the Button Groups



software (see in chapter 2.4 of this manual) before you burn you first CD. 

Step 1: Create an image assembly drawing

Create a new image assembly drawing for the images, which you will copy on a CD or DVD (CD-
/DVD-project  like  in  current  burning  programs).  You  can  produce  different  image  assembly 
drawings with different names (Illustration 22).

Illustration 22: Creation of new CD/DVD –projects

Step 2: Insert of DICOM images in one CD/DVD Project

You are able to save several images, image directories and images of one patient or all images, 
which are shot?? On the same day in one specific CD/DVD-Project. Besides you have to select the 
favoured object (image, directory, patient or date) and mark it. Afterwards you have to press the 
right mouse button. Now you can see a menu, where you can select the favoured object (Illustration
23). Above illustration shows you, that you are able to copy the directory with all images (on the 
left: 1st March 2003; on the right the patient ULTRASCHALL) of an existing image assembly 
drawing in [Musterman~]. Later you can burn them on CD or DVD.

Illustration 23: Menu "Send at ..."

Step 3: Burn a CD

To burn an existing CD/DVD project (in this case [cd1]) on a CD, you have to mark it, press on the 



button [s] and then on [On CD, DVD], or mark a CD/DVD Project with the right mouse button and 
select the option [Burning...] in the following menu (Illustration 24).

Attention: Play it safely and convince yourself that you've inserted an able blank CD in the CD- or 
DVD recorder. 

Illustration 24: Burn a CD/DVD

Step 4: Reject the CD/ DVD

Has the storage successfully completed you can take out the medium.

Step 5: Delete the image assembly drawing

If you don't need an image assembly drawing anymore, you can press with the right mouse button 
on the assembly drawing and select the option [delete].  The image assembly drawing is finally 
deleted.

Important information:

Check out the written medium after any burning- process (CD-/ DVD). So you can get sure, that the 
medium  works  totally  correctly  and  you  won't  delete  important  image  dates  that  you  haven't 
accurately saved.

4.3 DICOMDIR File Import   

The process of DICOMDIR imports can you see on Illustration 19 



 

4.4Print a DICOM-image

Select your favourite image and mark it. Afterwards press the right mouse button. In the attending 
menu, you can select the favourite option (Illustration 26).

Illustration 26: Printing of DICOM-images

The printing of DICOM-images takes place via print options of the operating system. Condition for 
this is a right installation of a printer in the operating system.



4.5 Import of DICOM-images

The program offers the possibility to get DICOM-images from any data stuff (floppy disks, hard 
disk, CD, DVD) and not only from the internal DICOM-Server. Besides you have to select the 
option [File -> Import] (Illustration 27).

Illustration 27: Import of DICOM-images

4.6 Creation and editing of voice or text comments
TI-jPACS is able to create, edit, play or write voice- or text- comments.
Such comments can be written on CDs/DVDs and readied with DICOM-Viewer from CD or DVD.

Creation of text or vice-comments
Select your favourite image and mark it. Afterwards press the right mouse button. In the attending 
menu, you can select the favourite option [Insert Audio-Comment] or [Insert Text-Comment] 
(Illustration 28).

Illustration 28: Insert of comments

After the selection of [Insert Text-Comment]-Menu-Item you can see text editor fame (Illustration
29) for inserting of text comments. You can save, cut, paste of Text. The last button serves to close 
of text editor.   

Illustration 29: Text editor



After the selection of [Insert Audio-Comment]-Menu-Item you can see voice recorder /player fame 
(Illustration 30) for record and playback of voice comments. You can record, play, stop, save of 
vice comments. The last button serves to close of text editor.   

Illustration 30: Voice recorder frame

Please select the quality of voice comments (per playback) before saving

4.7Changing of relevance of DICOOM -images

You can  change the relevance  for  DICOM Images  from “normally” (default)  to  diagnostically 
relevant (red mark) or to “relevant for education” (green mark) (see Illustration 22)

Illustration 31: Changing of image relevance 

4.8Export DICOM-images

The program offers the possibility to export DICOM-images as other image formats (Illustration
32). Besides you have to mark the favourite DICOM-image in the DICOM-management browser. 
After you’ve selected the menu point [save as …] you can change the selected image to another 
image format.



Illustration 32: Save as...

4.9Anonymization of DICOM-images
The program offers the possibility to anonymization of DICOM-images.  

Illustration 33: DICOM Anonymization

4.10Deletion of DICOM-images

Specific images and image directories can be deleted. First of all you have to select the object 
(image, directory, patient or date) by marking it. If you click the right mouse button there will be 
appear a dialog where you can choose the desired option (Illustration 34).



Illustration 34: Deleting of DICOM-images

The program has a trash, which includes all the deleted files and directories. By using the program 
intensive,  the  trash  could  be  very  full.  Because  of  this  it  is  recommended  to  clean  the  trash 
regularly. To do this you have to mark the symbol [trash]. Afterwards you have to click the right 
mouse button and to select the option [cleaning trash] (Illustration 35). It’s also possible to delete 
separated objects out of the trash. 

Illustration 35: Cleaning trash

4.11Restore deleted DICOM-images

You are able to restore deleted DICOM-images, which  still exist in the trash. Besides, you should 
mark the favorite image in the trash. Afterwards you have to press the right mouse button. In the 
appearing menu you can select the option [call deleting off] (Illustration 36).

Illustration 36: Restore deleted DICOM-images

4.12DICOM-Mail

You are able to send specific DICOM-images via Mail. Besides, you have to select the favorite 
images and mark it. Afterwards press the right mouse button. In the appearing menu you can select 



the option [send via E-Mail] (Illustration 37).

Illustration 37: E-Mail

This option requires the following conditions:

•You are connected to the internet
•The addresser has an available E-Mail address
•The addresser is registered at an E-Mail server
•The addresser has to know the right name of the E-Mail server (insert in the field ‘’hostname’, 
Illustration 37).

You are able to select between three choices:

•Send the DICOM-image unmodified 
•Send as JPEG
•Send as AVI

4.13 Send DICOM-images to a DICOM-server

After you have activated the plug-in for sending DICOM-images (chapter 4.8), you are 
able to send DICOM-images to other DICOM-able appliances via DICOM-protocol. 
Besides,  you have  to  publish  this  appliance  to  TI-jPACS.  Select the  menu option 
[options-> DICOM-send configuration]. Afterwards a configuration window appears 
where you can see the existing connections (Illustration 38).



Illustration 38: DICOM-Send configuration frame

To apply a new connection, you have to press the button [new connection…]. Afterwards, another 
window appears where you have to insert the connection information (Illustration 39). In the first 
field type the complete IP-address of the target computer or the hostname. In the field below you 
type  port  number  of  the  DICOM-appliance  on  the  target  computer  (104  e.g.).  In  the  field 
“connection-name”  you  can  select  a  name for  the  connection.  This  helps  you  to  close  up  the 
connection easier at a later date. If you press on button with the question mark you can see the list 
of the expandable settings. But you will only need them in exceptional cases.

Illustration 39: Configurations frame

**When dispatching DICOM data:
Calling Application Name:    STORESCU
Called Application Name:     ANY-SCP

In order to change this label, you must activate the "Extended attitudes" (see illustration above) in 



the frame for putting of a new DICOM connection and enter in the field under:
--aetitle MYLABEL --call LABEL_OF_CALLING_APPLICATION

• Instead of " MYLABEL " begin your “Application Title” for example “TI_jPACS”.
• Instead of " LABEL_OF_CALLING_APPLICATION " begin the “Application Title from 

other application”.

These data are stored and next time usable.

After you have inserted the required details press on the button [add]. 

To delete the existing connection, select the respective connection (Illustration 38) and  press on the 
button [remove connection].

Illustration 40: Send to (...) -menu

Now you can send a DICOM-image to a registered DICOM-appliance. Besides you should select 
the favorite image and mark it. Afterwards, press the right mouse button. In the appearing menu you 
can select the favorite option [send to: connection-name] (Illustration 40).

In the example (Illustration 40) the connection is send to ‘’Test connection’’.

You will be informed about the status after you have finished the transfer.

4.14 How to establish a connection to a DICOM-database

When the  plug-in  to  connect  to  a  DICOM-database  is  activated  (watch chapter  4.8),  DICOM-
images  can  be  transmitted  to  a  DICOM-database  through  the  DICOM-protocol.  The  DICOM-
database, installed on the receiving computer, normally has to know the transmitted application 
(here TI-jPACS). Maybe it is necessary to change the required preferences (watch the guide of the 
specific application).  The database has to be known by TI-jPACS. To reach this you have to choose 
the menu item [Database options -> DICOM-databases connection attitudes…->] (Illustration 41). 

Illustration 41: Menu for configuration of DICOM-DB Connections

Afterwards there will appear a configuration dialog, where are listed the actual connections, which 
were already established (Illustration 42).



Illustration 42: DICOM-databases connection attitudes

To create a new connection click the button [new connection…]. Then the new window will appear, 
where you should type the connection data (Illustration 43). In the first field “connection name” you 
can choose a name for the DICOM-database connection. Later this will make the identification 
easier (e.g.: DICOM Database Hospital X). In the next field, type the hostname of the receiving 
computer. In the third and fourth fields type the specific identifier of the database (called AE) and 
the own application (calling AE). In case of unknown data please ask the administrator for the 
database (target application).
Under the fourth field you have to fill the port number of the DICOM-database of the receiving 
computer (e.g.: 104).

Illustration 43: Configuration from new connections

After you have made the required data please click the button [add]. Then click on the button Add
You can delete a specific connection (Illustration 42) by clicking the button [remove connection].

To communicate with a registered DICOM-database, choose the menu item [Database options -> 
Connect to DICOM database: <...connection name...>]. In the image-management-browser there 
will  be  an  added  file-explorer,  which  makes  the  connection  to  the  database  [Create  (update) 
connection] (Illustration 44). 



Illustration 44: DICOM DB Explorer

In the window there you can see a list of all available patients. By clicking a patient you’ll get a list 
of the available studies etc. In case that a connection cannot be established there will appear an alert 
with the label “Search without any results”.

If the database doesn’t send you a message (it maybe because it is overloaded or there is another 
problem with the database), you will see the cursor-hour-glass for a longer time. In this case click 
the button [cancel] to cancel the connection.

By switching to the other Explorer-card [Search in database < …>] (Illustration 45) you can make 
search by name and gender. It is not necessary to type full name. You can type just 3 letters with 
star and you will get all patients whose names begin with those 3 letters.
 



Illustration 45: Searching in database

If you want to view a DICOM-image with the DICOM-viewer from DICOM DB Explorer, you can 
select it in the image management browser. Click with the right mouse button on it and select the 
option [Change to DICOM Viewer (full screen)] (Illustration 46). Hereupon you can see the image 
in the complete picture mode. You can select other options in this pop up menu, for example: [Send 
by Email] or [Send at <CD/DVD -Project>], etc.   



Illustration 46: Popup Menu in DICOM DB Explorer

In the image management-browser you can switch to the view of the local dates every time by 
clicking the tab [home-explorer].



5. DICOM Conformance
SOP Class Name SOP Class UID

Verification SOP Class 1.2.840.10008.1.1

Computed Radiography Image Storage 1.2.840.10008.5.1.4.1.1.1

CT Image Storage 1.2.840.10008.5.1.4.1.1.2

MR Image Storage 1.2.840.10008.5.1.4.1.1.4

Nuclear Medicine Image Storage 1.2.840.10008.5.1.4.1.1.20

Ultrasound Image Storage 1.2.840.10008.5.1.4.1.1.6.1

Ultrasound MultiFrame Image Storage 1.2.840.10008.5.1.4.1.1.3.1

Secondary Capture Image Storage 1.2.840.10008.5.1.4.1.1.7

Multi-frame Greyscale Byte Secondary Capture Image Storage 1.2.840.10008.5.1.4.1.1.7.2

Multi-frame Greyscale Word Secondary Capture Image Storage 1.2.840.10008.5.1.4.1.1.7.3

Multi-frame True Colour Secondary Capture Image Storage 1.2.840.10008.5.1.4.1.1.7.4

X-Ray Angiographic Image Storage 1.2.840.10008.5.1.4.1.1.12.1

X-Ray Radio fluoroscopic Image Storage 1.2.840.10008.5.1.4.1.1.12.2

RT Image Storage 1.2.840.10008.5.1.4.1.1.481.1

Digital X-Ray Image Storage - For Presentation 1.2.840.10008.5.1.4.1.1.1.1

Digital X-Ray Image Storage - For Processing 1.2.840.10008.5.1.4.1.1.1.1.1

Digital Mammography Image Storage - For Presentation 1.2.840.10008.5.1.4.1.1.1.2

Digital Mammography Image Storage - For Processing 1.2.840.10008.5.1.4.1.1.1.2.1

Digital Intra Oral X-Ray Image Storage - For Presentation 1.2.840.10008.5.1.4.1.1.1.2

Digital Intra Oral X-Ray Image Storage - For Processing 1.2.840.10008.5.1.4.1.1.1.2.1

VL Endoscope Image Storage 1.2.840.10008.5.1.4.1.1.77.1.1

VL Photographic Image Storage 1.2.840.10008.5.1.4.1.1.77.1.4

VL Microscopic Image Storage 1.2.840.10008.5.1.4.1.1.77.1.2

VL Slide Coordinates Microscopic Image Storage 1.2.840.10008.5.1.4.1.1.77.1.3

Positron Emission Tomography Image Storage 1.2.840.10008.5.1.4.1.1.128

Hard Copy Greyscale Image Storage 1.2.840.10008.5.1.1.30

Hard Copy Colour Image Storage 1.2.840.10008.5.1.1.29
Transfer syntaxes for lossy or lossless compressed DICOM-
Images:
RLE (lossles) **(only with RLE decoder-plug-in) 1.2.840.10008.1.2.5

JPEG (lossles, lossy) ** (only with JPEG decoder-plug-in) 1.2.840.10008.1.2.4.50 -….- 
1.2.840.10008.1.2.4.81

JPEG 2000(lossles, lossy) ** (only with JPEG 2000 decoder-plug-in)
1.2.840.10008.1.2.4.90
1.2.840.10008.1.2.4.91



6. Warranty, abolishment of the program bugs

We don't guarantee an error-free function of the software. The abolishment of errors is in producer's 
discretion.

7. Liability

The TI-jPACS Software is provided "as is" without any warranty of any kind. To the maximum 
extent  permitted  by  applicable  law,  the  TI-jPACS  developer  further  disclaims  all  warranties, 
including  without  limitation  any  implied  or  stated  warranties  of  merchantability,  fitness  for  a 
particular purpose, and no infringement. The entire risk arising out of the use or performance of this 
product and documentation remains with recipient. To the maximum extent permitted by applicable 
law, in no event shall the TI-jPACS developer or his suppliers be liable for any consequential, 
incidental,  direct,  indirect,  special,  punitive,  recursive,  or other damages whatsoever (including, 
without  limitation,  damages  for  loss  of  business  profits,  business  interruption,  loss  of  business 
information, personal injury, disruption of family life, or other pecuniary loss) arising out of this 
agreement or the use of or inability to use the product, even if the TI-jPACS developer have been 
advised of  the possibility  of  such damages.  Because  some states/jurisdictions  do not  allow the 
exclusion or limitation of liability for consequential or incidental damages, the above limitation may 
not apply to the recipient. The TI-jPACS developer, also, is not liable for anything that may happen 
after to your computer after the use of TI-jPACS.
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